# CONTENT

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Welcome</td>
<td>3</td>
</tr>
<tr>
<td>2. System Requirements</td>
<td>3</td>
</tr>
<tr>
<td>3. Installation</td>
<td>3</td>
</tr>
<tr>
<td>4. Recommendations concerning Data Security</td>
<td>3</td>
</tr>
<tr>
<td>5. Start</td>
<td>3</td>
</tr>
<tr>
<td>6. Help</td>
<td>4</td>
</tr>
<tr>
<td>7. Create and run a project</td>
<td>4</td>
</tr>
<tr>
<td>7.1 Start CODESYS and create a project</td>
<td>4</td>
</tr>
<tr>
<td>7.2 Write a PLC program</td>
<td>6</td>
</tr>
<tr>
<td>7.3 Define the Resource objects for running and controlling the program on the PLC</td>
<td>8</td>
</tr>
<tr>
<td>7.4 Run and watch the application on the PLC</td>
<td>10</td>
</tr>
<tr>
<td>7.5 Debug an application</td>
<td>12</td>
</tr>
<tr>
<td>8. Deinstallation, Modify, Repair</td>
<td>13</td>
</tr>
<tr>
<td>Change History</td>
<td>14</td>
</tr>
</tbody>
</table>
1 Welcome

Welcome to the CODESYS V3 Development System by 3S - Smart Software Solutions GmbH!

CODESYS is a device-independent PLC-programming system. Matching the IEC 61131-3 standard it supports all standard programming languages but also allows including C-routines and supports object orientated programming. In combination with the CODESYS Control Win V3 runtime system it allows multi-device and multi-application programming. The component-based structure makes possible a customer-specific configuration and extension of the user interface.

Before you are going to install regard the following on system requirements, installation and how to get further information.

2 System Requirements

Recommended:

- Operating system: Windows XP/7/8 (32/64 Bit)
- RAM: 4 GB
- Hard disk: 2 GB
- CPU: Dualcore

3 Installation

Perform the Setup_CODESYSV<Version>.exe to start the installation assistant which will guide you.

4 Recommendations concerning Data Security

In order to minimize the risk of data security breaches we recommend the following organizational and technical measurements for the system running your applications:

Avoid as far as possible to expose PLCs and PLC networks to public networks and internet. For protection use additional security layers like a VPN for remote access and install firewall mechanisms. Restrict access on authorized persons, if available change default passwords at start-up and modify them frequently. If you nevertheless want to publish your Web Visualization, then it is highly recommended to give it at least a simple password protection to prevent that anybody can access the functionality of your PLC over internet (for an example see the project "SimpleWebvisuLogin.project" provided with the standard setup of the programming system).

Use the latest versions of Gateway Server and Web Server. For web servers and gateway servers up to V3.4 SP4 Patch 2 a security vulnerability (US ICS CERT: ICS-ALERT-12-097-02) was detected. This is fixed as from V3.5.

5 Start

Start CODESYS from the Start menu: Per default the path is Programs – 3S CODESYS – CODESYS – CODESYS V<version>.

Alternatively use the CODESYS icon which is available on the desktop after installation.
6  Help

Online help is provided via the ‘Help’ menu. There you find the commands to open a Contents view of the help, the Index view for searching by keywords or the Search view for full-text search.

7  Create and run a project

See in the following a description of how to create a simple project containing a PLC program, further how to load this program via a Gateway Server to the PLC (target device) and to get it run and monitored. The PLC runtime system used for this example project per default is provided with the CODESYS setup.

The sample program will be written in Structured Text language and consist of a program PLC_PRG and a function block FB1. PLC_PRG will contain a counter variable ivar and call function block FB1; FB1 will get input "in" from PLC_PRG, will add "2" on this input and will write the result to an output out; out will be read by PLC_PRG.

(Regard that the following descriptions refer on the default configuration of the user interface provided with the currently installed version of the programming system.)

7.1  Start CODESYS and create a project

(1)  Start CODESYS

From the Start menu on your PC choose

   Programs  > 3S CODESYS > CODESYS > CODESYS V<version>

Alternatively you can start via the CODESYS Icon that will be available on the desktop after installation.

The programming system will be automatically started with a predefined profile. So currently you do not to have select a profile.

(2)  Create a project

To create a new project, choose command New project from the File menu:

In the New Project dialog select Standard project in the ‘Templates’ field and enter a Name and a Location path for the project file. Press OK to confirm.
A wizard dialog will open:

Choose device CODESYS Control Win V3 and programming language Structured Text for PLC_PRG. Press OK to open the new project.

The project name now will appear in the title bar of the CODESYS user interface and as a symbolic root node in the POUs and the Devices view windows.

The POUs window contains the Project Settings.

The Devices window shows tree with a device **Device (CODESYS Control Win V3)** of type CODESYS Control Win V3 with an **Application** adjoined below. The latter includes the program **PLC_PRG** to be edited in Structured Text and the obligatory Task Configuration defining a **MainTask** that controls PLC_PRG.

Furthermore there is a **Library Manager**, automatically including the library IoStandard.library necessary for IO-configurations and the Standard.library providing all functions and function blocks which are required matching IEC61131-3 as standard POUs for an IEC programming system.

(At the moment do not care about the additional node **Plc Logic** inserted below the device node **Device (CODESYS Control Win V3)**. It is just a symbolic node indicating that the device is a "programmable" one.)

The symbolic device name can be renamed by selecting this entry, opening an edit field with the <Space> key and entering another name instead of "Device". Do this and enter **"PLCWinNT"** instead.
7.2 Write a PLC program

(3) Declare variables in PLC_PRG

Select the default POU "PLC_PRG" which is already available in the POUs window.

In the center part of the window the ST language editor window for 'PLC_PRG' will open. The editor consists of a declaration part (upper) and a "body" (lower part), separated by a screen divider.

The declaration part shows line numbers at the left border, the POUs type and name ("PROGRAM PLC_PRG") and the embracing keywords "VAR" and "END_VAR" for the variables declaration.

The body is empty, only line number 1 is displayed:

```plaintext
PROGRAM PLC_PRG
VAR
  ivar: INT;
  fbinst: FB1;
  erg: INT;
END_VAR
```

Instead of this you could directly type a line in the implementation part of the editor (body) and use the Autodeclare function, see (4).

(4) Enter programming code in the body of PLC_PRG

In the body part of the PLC_PRG editor put the cursor in line 1 and enter the following lines:

```plaintext
ivar := ivar+1;    // counter
fbinst(in:=11, out=>erg);  // call function block FB1, input parameter
// with input parameter “in”
// output is written to “erg”
```

Instead of steps (3) and (4) you could use the Auto Declaration feature: Immediately enter an implementation line in the body of the program, then press the <Return>-key. For each not yet declared variable found in the new line the Auto Declare dialog will open, where you can do the declaration settings:
The variables name and scope as well as the current POU (Object) will be filled in automatically. Enter the desired type and initialization value according to the declaration described in (3). Regard that comments if you define them here in the autodeclaration dialog, will not be inserted indicated by "//" like shown above, but as an xml-description in the declaration part and will later be usable for documentation purposes.

Confirm the dialog with OK. This will enter the declaration of \textit{erg} in the declaration part of the POU with the comments ahead:

\begin{verbatim}
FUNCTION_BLOCK FB1
VAR_INPUT
  in: INT;
END_VAR
VAR_OUTPUT
  out: INT;
END_VAR
VAR
  ivar: INT:=2;
END_VAR

out:=in+ivar;
\end{verbatim}

(5) Create a further programming POU (ST function block FB1)

We add a function block which will add "2" on the input given by variable "in". The result will be written to output "out".

Choose command \textbf{Add object} from the \textbf{Project} menu.

Select 'POU' in the left part of the 'Add Object' dialog. Enter a Name "FB1" for the POU, activate option \textbf{Function Block} in the Type section.

Choose ‘Structured Text (ST)’ for the \textbf{Implementation language}.

Press button \textbf{Open} to confirm the object settings.

A further editor window will open for the new function block FB1. Declare there the following variables, in the same way as having done for PLC_PRG:

\begin{verbatim}
FUNCTION_BLOCK FB1
VAR_INPUT
  in: INT;
END_VAR
VAR_OUTPUT
  out: INT;
END_VAR
VAR
  ivar: INT:=2;
END_VAR

out:=in+ivar;
\end{verbatim}
7.3 Define the Resource objects for running and controlling the program on the PLC

(6) Start Gateway Server and PLC

Start Gateway Server:

The Gateway Server is started automatically at system start as a service. Make sure that there is an icon in the system tray, indicating that the gateway is running. If the icon is looking like , the gateway currently is stopped.

(This icon is part of the GatewaySysTray program which is available for controlling and monitoring the Gateway service. It provides a menu with a start and a stop command, thus allowing the user to stop or restart the service manually. The menu also includes the command Exit Gateway Control, which just terminates the GatewaySysTray program, not however the Gateway service. The GatewaySysTray program is started automatically when Windows is started, however it also can be started manually via the Programs menu.)

Start PLC:

The PLC (CODESYS Control Win V3) is available as a service at system start. It is represented by an icon in the system tray: for status 'stopped', for status 'running'. For security reasons (Protection against unauthorized access) as from V3.5 SP2 the PLC service will not any longer be started automatically at the system start. It must be started manually by command 'Start PLC' from the menu which you open by a mouse-click on the icon.

CAUTION: This icon is part of the CODESYSControlSysTray program which is available for controlling and monitoring the CODESYS Control Win V3 service. It provides a menu with a start and a stop command, thus allowing the user to stop or restart the service manually. The menu also includes the command Exit PLC Control, which just terminates the CODESYSControlSysTray program, not however the ControlService. The CODESYSControlSysTray program is started automatically when Windows is started, however it also can be started manually via the Programs menu.

(7) Set the "Active Application"

In the Devices window the name 'Application' is displayed in bold letters. This means that this application is set as "active application". Thus all commands and actions concerning the communication with the PLC will refer to this application. In order to set an application as "active one" select the application entry in the Devices window and choose command Set Active Application from the context menu.

(8) Configure a communication channel to the PLC

Perform a double-click on entry "PLCWinNT (CODESYS Control Win V3)" in the devices window. The dialog "PLCWinNT" will open with subdialog "Communication Settings". Here you have to set up the connection between the PLC (target, device) and the programming system according to the following steps. The resulting connection will finally be entered in the line below Select network path to the controller:

If this is your first communication setup with CODESYS V3, you now have to define the local Gateway Server. (If you have defined the server already in previous sessions, it will be displayed in the communication settings dialog as shown in the figure on the next page. In this case you can skip this step and continue with defining the communication channel to the target, see also on the next page.)

The server is provided with the CODESYS setup. Press button Add gateway to open the Gateway dialog:
Enter a symbolic **Name** for the Gateway, define the Driver type "TCP/IP" and enter IP-address "localhost" (Perform a double-click on the column field to open an edit frame). Leave the setting for the Port. Confirm with **OK**.

The gateway will be entered in the field on the left part of the Communication Settings dialog and the name of the Gateway will be added to the selection list under 'Select the network path to the controller'. When the gateway is properly running, a green bullet is displayed before the entry, otherwise a red one:

Now define a channel to the target device which should be connected via the set gateway:

Use button **Scan network** to search for available devices in your local network.

You should at least find the PLC installed with the CODESYS setup: It will be displayed indented below the gateway: instead of "WST06 [003C]" shown in the picture below you should find the name and address of your computer.
Now select the PLC (device) entry and use button **Set active path**.
This will set this communication channel as the active one, which means that all actions concerning communication will exactly refer to this channel. Regard this later when you may have set up several communication channels in your project.

The settings will be applied automatically, you can leave the Communication dialog now.

### 7.4 Run and watch the application on the PLC

**(9) Compile and load application to the PLC**

If you just want to check your "active" application program for syntactic errors, perform command 'Build' (Context menu when application object is selected, Build menu) or use <F11>.

Attention: No code will be generated in this case. Error messages will be displayed in the Messages window which is placed at the lower part of the user interface per default.

Even if this syntactical check has not be done before, you can log into the PLC. (Therefore make sure, that the PLC is running, that is the symbol in the system bar is colored).

Use command **Login** (context menu when the application object is selected). If the communication settings have been configured as described in (8) the following message box will appear (otherwise you will be asked to correct the communication settings):

Confirm with Yes to start the compilation and download of the application.

The compile messages will be displayed in the Messages window. If the project has been created correctly, no compilation errors are to be expected, so that the application can now be started, see (11).

**(10) Start and monitor application**

Having created a 'standardproject' and downloaded the error-free application 'Application' as described in the previous steps, this application can now be started on the device CODESYS Control Win V3.

**Starting the application on the PLC:**
Perform command **Start**, which is in the context menu per default, when the application object is selected. In consequence the program starts running.

**Monitoring the application:**
There are three possibilities for watching the variables of the application program:

1. Online views of the particular POUs.
2. Writing and forcing variables
3. Watch views with defined watch lists
1. Online view of a POU

This view of a POU shows the current values of the contained expressions in the form of a table in the declaration part, and – if activated – in the form of “inline monitoring” also in the implementation part.

In order to open the online view, perform a double-click on "PLC_PRG" in the Devices window or select this entry and choose command 'Edit object' from the context menu.

In the lower part of the view you see the code lines as entered in offline mode, supplemented by the little inline monitoring windows behind each variable, showing the actual value. In the upper part a table shows the watch expressions of the POU, i.e. the current values of the respective variables in application "Application" on the PLC.

![Online view of a POU](image)

2. Writing and forcing variables:

You can write or force a "Prepared value" to variable ivar on the PLC, which means that ivar will be set to this value at the beginning of the next cycle. Perform a double-click on the field in column Prepared value, enter a desired integer value and leave the field by <Return> or by a mouse-click outside of the field. Perform command 'Write values' resp. 'Force values' (Debug menu) to write or force this value to the PLC. You will see the result at once in column Value.

3. Use the watch views:

Watch view windows can be used to configure specific sets of watch expressions of the application, e.g. for the purpose of debugging.

From the View menu use command 'Watch' -> 'Watch1'. The watch window will open.

In column Expression perform a mouse-click in the first line of the table to open an edit frame. Enter the complete path for variable ivar which should be monitored:

"PLCWinNT.Application.PLLC_PRG.ivar". It is recommended to use the input assistant via button for this purpose. Close the edit frame with <Return>. The type will be added automatically.

Do the same for the further variables. The watch list shown in the next picture just contains expressions of PLC_PRG, but of course you might create a set of any variables of your project. Regard that for instance variables, e.g. for the FB1-instances, it is sufficient to enter the expression "PLCWinNT.Application.PLLC_PRG.fbinst". The particular variables will be entered automatically and the corresponding lines can be opened via the plus-symbol: The current value of a variable is displayed in the 'Value' column:

![Watch view](image)

If not yet done, now perform command 'Start Application' from the Online menu. The application will be started on the PLC and the current value will be displayed in column Value:
Writing and forcing of values is possible like described above in 2.

To disconnect from the PLC perform command 'Logout' from the Online menu.

7.5 Debug an application

(11) Set breakpoint and step through the program

In online mode you can set breakpoints as defined break positions for the program execution.

When the program has reached a breakpoint you can execute the program in single steps. At each halt position you see the current value of the variables in the monitoring views.

Try the following:

Select line 1 of PLC_PRG. Use key <F9>, which equals the command 'Toggle Breakpoint' from the Debug menu.

The breakpoint will be indicated. If the application currently is in STOP state, this will look like:

```
1  ivar INT :=ivar INT := ;  // counter
2   fbinst(in 11 :=ll, out 10 :=cry 12 :=);  // call function block of type FBI
    // with input parameter "in"
    // output is written to "cry" RETURN
```

A running application will stop at a breakpoint:

```
1  ivar INT :=ivar INT := ;  // counter
2   fbinst(in 11 :=ll, out 19 :=cry 12 :=);  // call function block of type FBI
    // with input parameter "in"
    // output is written to "cry" RETURN
```

Now you can step further by using <F8>, which represents command Step Into from the Debug menu and therefore will step also into the function block instance. To skip the steps of the function block use <F10> which equals the command Step Over. Each variable value currently read from the PLC will be displayed.

You might also have a look at the Breakpoints dialog to be opened via command Breakpoints from the View menu. Here, the breakpoints currently set can be viewed and edited and new breakpoints might be entered.

Regard also that the breakpoint positions will be remembered when you log out. They will be indicated by faded red bullets.

Now you have built and run your first project with CODESYS V3. For further use of the programming system please see the online help.

We wish you successful programming. We appreciate each feedback.
8 Deinstallation, Modify, Repair

Deinstallation

Normally you can install new versions of CODESYS without having to de-install the current version from your system. In case you want to de-install also execute Setup_CODESYSV<version>.exe. In the start dialog of the installation wizard activate option ‘Remove all installed features’ and use button ‘Next’. Alternatively use the common deinstallation procedure via the System Control dialogs of your system.

Modify

If you want to modify the installation parameters, e.g. the selection of installed components, execute Setup_CODESYSV<version>.exe and choose option ‘Modify’ in the installation wizard start dialog. Use button ‘Next’ to run through the installation dialogs and modify the settings, having made during the previous installation, as desired.

Repair

If for any reasons the installation is not proper, you might try to “repair” it. For this purpose execute Setup_CODESYSV<version>.exe and choose option ‘Repair’ in the installation wizard start dialog. The installation will be done once more as configured during the previous run.
## Change History

<table>
<thead>
<tr>
<th>Version</th>
<th>Description</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1</td>
<td>Issued</td>
<td>16.05.2006</td>
</tr>
<tr>
<td>0.2</td>
<td>Description of sample project</td>
<td>26.01.2007</td>
</tr>
<tr>
<td>0.3</td>
<td>Update of sample project, Review</td>
<td>08.02.2007</td>
</tr>
<tr>
<td>0.4</td>
<td>Corrections acc. to Review</td>
<td>09.02.2007</td>
</tr>
<tr>
<td>1.0</td>
<td>Release</td>
<td>09.02.2007</td>
</tr>
<tr>
<td>2.0</td>
<td>Release after corrections in chap.6 concerning device name at several positions</td>
<td>21.02.2007</td>
</tr>
<tr>
<td>3.0</td>
<td>Release after adaptations in chap.6.3 (default device) and 6.4 (monitoring possibilities)</td>
<td>26.03.2007</td>
</tr>
<tr>
<td>4.0</td>
<td>Release after adaptations to CODESYS V3.1.3.0 according to the German document version 4.0</td>
<td>14.11.2007</td>
</tr>
<tr>
<td>4.1</td>
<td>Adaption to CODESYS V3.2 acc. to online help</td>
<td>20.02.2008</td>
</tr>
<tr>
<td>5.0</td>
<td>Formal Review, Release</td>
<td>28.02.2008</td>
</tr>
<tr>
<td>6.0</td>
<td>Adaption to CODESYS V3.2.0.4 acc. to online help, Release</td>
<td>04.07.2008</td>
</tr>
<tr>
<td>7.0</td>
<td>Adaption to CODESYS V3.4.0.0 acc. to online help, Release</td>
<td>19.03.2010</td>
</tr>
<tr>
<td>8.0</td>
<td>CDS-17521</td>
<td>05.11.2010</td>
</tr>
<tr>
<td>9.0</td>
<td>Adaption to CODESYS V3.5.1.0 online help, chap.4 (security recommendations) added, Release</td>
<td>29.05.2012</td>
</tr>
<tr>
<td>9.2</td>
<td>CDS-31487 (no automatic start of CODESYS Control Win)</td>
<td>09.11.2012</td>
</tr>
<tr>
<td>10.0</td>
<td>Release for CODESYS V3.5.2.0</td>
<td>28.11.2012</td>
</tr>
<tr>
<td>11.0</td>
<td>New template applied (templ_tecdoc_en_V1.0.docx); Formal Review, Release</td>
<td>03.03.2014</td>
</tr>
<tr>
<td>11.1</td>
<td>Update for CODESYS V3.5.8.0</td>
<td>27.11.2015</td>
</tr>
<tr>
<td>12.0</td>
<td>Release for CODESYS V3.5.8.0</td>
<td>30.11.2015</td>
</tr>
<tr>
<td>12.1</td>
<td>Geographic Restrictions added</td>
<td>12.09.2016</td>
</tr>
<tr>
<td>14.1</td>
<td>Geographic Restrictions removed</td>
<td>17.10.2016</td>
</tr>
<tr>
<td>15.0</td>
<td>Release</td>
<td>26.06.2018</td>
</tr>
</tbody>
</table>